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In this section you will learn: 

 What is Seavus Project Viewer™ 

 Who can use Seavus Project Viewer™ 

Introduction 

Seavus Project Viewer™ is a complete viewer for Microsoft® Project plans stored 

in .mpp files. It facilitates excellent collaboration in those projects where people 

and teams need to view and share information from project managers. 

Seavus Project Viewer™ is a lightweight and fast standalone application that 

reads the native .mpp file format and does not require a previous installation of 

Microsoft® Project on the user’s computer. 

It is capable of reading project information from project plans created in 2007, 

2010, 2013 and 2016 and displays an extensive set of views over the project 

information. 

The first version of Seavus Project Viewer™, 3.0, closely matches the capabilities 

of Microsoft® Project 2007, Microsoft® Project 2010, Microsoft® Project 2013 

and Microsoft® Project 2016 when working with read-only project plans. It also 

provides a very close look & feel/implementation of the features in Microsoft® 
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Project and requires no additional training for those users with previous 

Microsoft® Project experience. 

If you would like to read about the new enhancements in version 3.0, see section 

“What’s New in Using Seavus Project Viewer™” in this manual. 

For additional information about the benefits of Seavus Project Viewer™ that 

individual users and organizations can gain by using Seavus Project Viewer™, 

see the section titled "Benefits of Using Seavus Project Viewer™" in this manual. 

What’s New in Using Seavus Project Viewer™ 

Seavus Project Viewer™ 3.0 contains an extensive set of additional features for 

working with project plans. 

Below is the list of supported options categorized by view types: 

New Features 

 Support for Microsoft® Project 2016 file format.  

 Support for Mac OS X 10.11 “El Capitan”. 

Benefits of Using Seavus Project Viewer™ 

With Seavus Project Viewer™, users are able to open native Microsoft® Project 

files (.mpp) and read/view and print project plans while eliminating the need to 

purchase the more expensive Microsoft® Project suite of products. 

Typically, Users can be categorized into three groups: Team Members 

(personnel involved in the project implementation), Executives (executive 

management supervising the projects) and External users (vendors, distributors, 

sub-contractors, customers, i.e. all personnel outside the organization involved 

in project implementation or monitoring). Analysis shows that the number of 

users with project plan viewing needs is significantly greater than the number 

of users that create project plans. 

Due to high cost involved in using a full copy of Microsoft® Project for users 

with occasional need to view project plans, many organizations decide to 
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provide project information to them by using exported files or static copies 

(pictures) of the plans. 

These static views often leave out critical information that can only be seen by 

looking at several different views of the same project. For example, a user might 

need to look at the Gantt chart and then look at the ‘task information’ for a 

selected task and then look at the resources assigned to that particular task.  

This information is often missing when static views are given to users.  There is 

a more productive way for companies to share this information. 

By using Seavus Project Viewer™ with its complete viewing capabilities, 

organizations can improve their project execution, control and monitoring 

processes by providing the same information to all users involved in a project. 

Seavus Project Viewer™ enables project managers to communicate with the rest 

of the project users by showing all formatting, drawings, highlighting, grouping, 

and data organization in general as defined in Microsoft® Project. 

Finally, Seavus Project Viewer™ displays project information and views with 

100% accuracy, presenting the same project views as the project manager 

created them in Microsoft® Project. 
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In this section you will learn: 

 About the menus and toolbars in Seavus Project Viewer™ 

 About the ribbons in Seavus Project Viewer™ 

 About the filters, groups, tables and reports in Seavus Project Viewer™ 

 About the additional features available in Seavus Project Viewer™ 

Menus 

File 

This menu allows you to open project plans, print the opened plan, exit the 

program, etc. The table below shows the available actions found under this 

menu. 

 Feature Description 

 Open… Shows the Open File dialog where you can browse 

for and select a project plan (.mpp, file format) to 

open in Seavus Project Viewer™.  

 Recent Files  This is a sub-menu that contains a list of files you 

have recently opened, providing a quick shortcut 

option for opening them again without going 

through the Open File dialog. 

 Close Closes the currently opened file. 

 Print Shows the Print dialog where you can specify the 

printing options, such as selecting printer, select 

the paper size and orientation, number of copies, 

etc. 

2.Chapter : User 

Reference  
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Additional reading 

 Go to the “Window” menu reference for information about opening 

multiple files in Seavus Project Viewer™ at once 

Edit 

This menu allows you to search through the task and resource information or 

directly go to a task or a position on the timeline in the selected view. The table 

below shows the available actions found under this menu. 

 Feature Description 

 Scroll to task Moves to the area on the Gantt Chart containing 

the bar for the selected task 

Additional reading 

You can read everything about views in Seavus Project Viewer™ in the “Views” 

section of this manual. 

View 

This menu provides options for the user to switch between the different views, 

switch the tables associated with a view, view reports, zoom the current view, 

etc. The table below shows the available actions found under this menu. 

 Feature Description 

 [Task Views] In this section of the View menu, a list of task 

views (views showing tasks in different ways) 

which are selected to be shown in the menu 

for a quick access (e.g. most frequently used 

ones) is listed. 

 [Resource Views] In this section of the View menu, a list of 

resource views (views showing resources in 

different ways) which are selected to be 

shown in the menu for a quick access (e.g. 

most frequently used ones) is listed. 

 Table: [CurrentTable]  This item shows the currently associated table 

with the view currently active in the display. It 

also opens a sub-menu with options to 

change the associated table.  
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 Filtered for: [CurrentFilter]  Shows the currently active filter and opens up 

a sub-menu containing various filtering 

options available for the current view.  

 Sort  Opens up a sub-menu containing various sort 

options available for the current view.  

 Hide Toolbar Hides the application’s toolbar from the 

working space 

 Customize Toolbar Opens the dialog for customizing the look of 

the application’s toolbar. 

 Enter Full Screen Maximize the presentation area on the entire 

screen 

Additional reading 

 You can read everything about views and related functionality in Seavus 

Project Viewer™ in the “Views” section 

Tables 

This menu provides options to change the table associated with a view and 

switch to some of the other available tables or create a completely new table of 

your own. The table below shows the available actions found under this menu. 

 Feature Description 

 [Tables] In this section of the Tables sub-menu, a list of 

task or resource tables (depending of the view 

currently active) which are selected to be shown in 

the menu for a quick access (e.g. most frequently 

used ones) is listed. Usually, i.e. by default, this 

group contains the same tables as in Microsoft® 

Project when started for the first time. Clicking on 

one of the tables changes the table associated with 

the currently active view. 

Additional reading 

 You can read everything about views and related functionality in Seavus 

Project Viewer™ in the “Views” section 

Filters 

This sub-menu contains different filtering options. They are shown in the table 

below. 
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 Feature Description 

 [Filters] This section of menu items contains a list of filters 

that are selected to be accessible through the 

menu (as a quick access list). Usually, i.e. by 

default, this section contains the same filters as in 

Microsoft® Project when started for the first time. 

Clicking on one of the filters activates the 

particular filter for the currently active view. 

Additional reading 

 You can read everything about filters and filtering functionality in Seavus 

Project Viewer™ in the “Filters” section 

 In addition, you can check which views support filtering functionality in 

Seavus Project Viewer™ in the "View" section 

Sort 

This sub-menu contains different sorting options. They are shown in the table 

below. 

 Feature Description 

 [Sorts] Depending on the view type (showing tasks or 

resources), this section of menu items contains a 

list of pre-defined sorting options. 

For task views, the available options are: 

 by Start Date 

 by Finish Date 

 by Priority 

 by Cost 

 by ID 

For resource views, the list contains the following 

options: 

 by Cost 

 by Name 

 by ID 

Clicking on one of the options, the tasks or 

resources shown in the active view are sorted by 

the field specified in the options in ascending 

order. 

Additional reading 



Chapter : User Reference 

Page | 10 

Seavus Project Viewer User Manual 

 You can check which views support sorting functionality in Seavus Project 

Viewer™ in the “Views” section 

Insert 

This menu provides options to insert fields in the different views. The table 

below shows the available actions found under this menu. 

 Feature Description 

 Insert Column Inserts a new field (column) in the associated table 

of the currently active view. 

 Hide Column Hides selected field (column) in the associated 

table of the currently active view 

Additional reading 

 You can read everything about tables and related functionality in Seavus 

Project Viewer™ in the "Tables" section 

 In addition, you can read everything about views and related functionality 

in Seavus Project Viewer™ in the “Views” section 

Format 

This menu provides options for formatting different aspects of the currently 

active view. The table below shows the available actions found under this menu. 

 Feature Description 

 Timescale… Open a submenu where you can change the 

timescale units for better viewing the project 

details 

Additional reading 

 You can read everything about views and related functionality in Seavus 

Project Viewer™ in the “Views” section. This section also gives you an 

overview of the supported layout, formatting and styles options, as well 

as supported detail field for each view type 

 The options for formatting the timescale are covered in details in the 

“Timescale formatting” section 



Chapter : User Reference 

Page | 11 

Seavus Project Viewer User Manual 

Project 

This menu provides various functions for organizing the project information in 

the active view and accessing the information dialogs for the project or the 

selected task, resource, or assignment. The table below shows the available 

actions found under this menu. 

 Feature Description 

 [Task/Res. Information] Opens up the information dialog for the selected 

task or resource. 

 Project Information… Opens up the Project Information dialog. 

Additional reading 

 Section “Information dialogs” provides more information about the 

project, task, resource, and assignment dialogs available in Seavus 

Project Viewer™. 

Window 

This menu contains options for splitting the Seavus Project Viewer™ window in 

two parallel views or open another window with a different (or the same) file. 

The table below shows the available actions found under this menu. 

 Feature Description 

 Minimize Minimize the active window to the Dock 

 Zoom  

 Bring All to Front Bring all application’s windows together to the 

front ahead of other applications windows  

Help 

This menu provides you with access to the integrated help system in Seavus 

Project Viewer™ and the Live Update functionality for Seavus products. The table 

below shows the available actions found under this menu. 

 Feature Description 

 Search Search a specific term in the project file 

 Seavus Project Viewer Help Opens up the Contents menu of the context 

help, which lets you to navigate the entire 

help through the available categories 

organized in hierarchy 
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 Seavus Project Viewer Support Opens up the internet browser with the 

application’s customer support page loaded in 

it 

 What’s New in Seavus Project 

Viewer  

Opens up the internet browser with the 

product overview page loaded in it 

 Seavus Project Viewer™ web 

site 

Opens up the internet browser with the 

application’s main page loaded in it 

Toolbar 

Standard Toolbar 

This toolbar contains the most common actions used when viewing the projects 

in Seavus Project Viewer™, as shown on the figure below: 

 

The following tables lists the commands found in the toolbar. 

 Feature Description 

 Print Displays the print dialog where you can set the 

printing options for the active view 

 Gantt Chart A list of tasks and related information, and a chart 

showing tasks and durations over time. Use this task 

view to the list of tasks and their schedule 

 Task Sheet A list of tasks and related information. Use this task 

view to review task information in a spreadsheet-like 

format. 

 Resource Sheet A list of resources and related information. Use this 

resource view to review resource information in a 

spreadsheet-like format. 

 Insert Columns Inserts a new field (column) in the associated table of 

the currently active view 

 Hide Columns Removes the existing field (column) from the 

associated table of the currently active view 

 Task/Resource Info Displays task or resource information in the standard 

Information dialogs. 

 Project  Info Displays parameters that describe the current status of 

the project plan. 

 Scroll to task Moves to the area on the Gantt Chart containing the 

bar for the selected task. 
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 Filter Contains a list of filters that are selected to be 

accessible through the drop-down menu. Clicking on 

one of the filters activates the particular filter for the 

currently active view. 

 Sort Depending on the view type (showing tasks or 

resources), this drop-down menu contains a list of 

pre-defined sorting options. 

 Table The drop-down list contains predefined task or 

resource tables (depending of the view currently 

active). Clicking on one of the tables changes the table 

associated with the currently active view. 

 Timescale Change the timescale units for better viewing the 

project details 

 Zoom  

Additional reading 

 You can read everything about views in Seavus Project Viewer™ in the 

“Views” section of this manual 

 Section “Information dialogs” provides more information about the 

project, task, resource, and assignment dialogs available in Seavus 

Project Viewer™. 

 More information about creating own toolbars, or customizing the 

existing ones can be found in the “Customizing toolbars” section 

Views 

Overview 

Views are Microsoft® Project’s way of communicating with you. Therefore, they 

are fully supported in Seavus Project Viewer™. They display in a particular format 

a subset of the information you typically enter in Microsoft Project. That subset 

of information gets stored in Microsoft Project plan (.mpp file) and can be 

displayed in any view in Seavus Project Viewer™ that calls for that information. 

You use a view in Seavus Project Viewer™ to display information about tasks, or 

resources. Because a view displays closely related information in a logical and 

easy-to-read format, you can quickly see and understand the status of a 

particular aspect of your project. 



Chapter : User Reference 

Page | 14 

Seavus Project Viewer User Manual 

Seavus Project Viewer™ supports the following types of views: 

 Gantt Chart view presents information graphically. It consists of a table 

on the left and a chart showing the tasks as bars on a timeline on the 

right: 

 

 Sheet views (such as the Task Sheet and Resource Sheet) present 

information in rows and columns, i.e. they resemble a spreadsheet or 

table of information. Rows contain information about tasks or resources. 

Columns are fields with specific information about tasks or resources. 

(Columns in Seavus Project Viewer™, similarly to Microsoft® Project, are 

typically referred to as fields.) 
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 Team Planner view combines the information about the resources 

assignments in the project plan and the tasks that missed resources. It 

consists of tasks presents as bards in the Gantt Chart combined with 

resource’s assignment information. Tasks that missed resources are 

presents only with bars in the Gantt Chart 

Views are made up of individual components such as tables, filters, groups, and 

details. To focus on specific task, resource, or assignment information in a view, 

you can display a different table and change the filter or group that is applied. 

In some views, you can also change the set of details that is applied. 

 A table is a set of fields displayed in the sheet portion of a view as 

columns and rows. The default table displayed differs by view. 

 A filter is a set of criteria for displaying specific tasks, resources, or 

assignments. The default filter applied to a view is either the All Tasks 

filter (for task views) or the All Resources filter (for resource views). 

Changing tables or filters does not add or delete information stored in .mpp 

file; it merely presents a portion of the information in different ways. If the 

project manager in Microsoft® Project chooses to present the project 

information in a particular way, he or she can customize and save a view with 

different default settings for tables and filters. Seavus Project Viewer™ will read 
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the settings as saved by the project manager and show you the view in the same 

way as it appears in Microsoft® Project. 

Before project managers distribute information about their project in .mpp files 

after having selected a view, they may want to format the view to better meet 

their needs or apply an organizational standard for presenting projects. To 

make the project easier to read, project managers usually highlight milestones, 

change the colors of task bars to match corporate standards, or change field 

titles to match organization's terminology. When the project manager saves the 

project in an .mpp file, the formatting information is stored along the project 

information in the same file. Seavus Project Viewer™ reads this information 

when opening .mpp files, showing the same formatting and visual styles as in 

Microsoft® Project. 

Gantt Chart 

Description 

The Gantt Chart view displays project information in two ways: The left side 

displays information as a sheet and the right side displays information as a chart. 

The sheet portion displays information about the project's tasks, such as when 

they start and end, how long they are, and the resources assigned to them. 

The chart portion displays each task graphically, most often as a task bar. The 

bar's length and position on the timescale indicate when that task begins and 

ends. In addition, the position of one task bar in relation to another indicates 

whether the tasks follow one another or overlap. 

Additional (custom) views 

If the project manager creates additional Gantt Chart views in Microsoft® Project, 

they can be viewed in Seavus Project Viewer™ along with the standard ones as 

well. 

Best uses 

Use the different Gantt Chart views to: 
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 View tasks graphically while still having access to detailed information 

about the tasks. (Gantt Chart view) 

Customization 

Seavus Project Viewer™ is able to read the following formatting and style 

customizations made by the project manager for each of the Gantt Chart views 

in Microsoft® Project and saved in the .mpp file: 

 Layout options – options for drawing the links between tasks, date format, 

bar height, etc. 

 Bar styles – the styles for drawing the bars and displaying information 

about bars in the particular view 

 Bar formatting – the specific formatting of a particular bar in the chart, in 

case the project manager intentionally changed the format to make the 

task stand-out from the others by its visual presentation 

 Timescale formatting – the formatting of the different timescale tiers, as 

well as the calendar and presentation of the working and non-working 

days 

 You are also able to customize the Gantt Chart views in Seavus Project 

Viewer™, using one of the following opportunities: 

 Change the different Layout options for the active Gantt Chart view. 

 Display, hide, or change the appearance of the timescale tiers. 

Tables 

The sheet portion displays categories of information about the tasks, arranged 

in tables. The default table for the Gantt Chart views depends on the view. For 

example, the default table for the standard Gantt Chart view is the Entry table. 

You can also select any of the task tables to display information about the 

project's tasks. 

Filters 

The Gantt Chart view can use any of the task filters to display only the tasks you 

want to see. When you select a filter, both the sheet and chart portions of the 

Gantt Chart display the information as defined by that filter's criteria. The 

default filter is the All Tasks filter. 
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Task Sheet 

Description 

The Task Sheet view displays information about each task (such as task duration, 

start and finish dates, and cost) in a sheet format. 

Standard (default) views 

Seavus Project Viewer™ supports the standard Task Sheet view, available in 

Microsoft® Project by default. 

Additional (custom) views 

If the project manager creates additional Task Sheet views in Microsoft® Project, 

they can be viewed in Seavus Project Viewer™ as well. 

Best uses 

Use the Task Sheet view to: 

 View the list of tasks and task information quickly when you do not need 

to see the information graphically over time.  

 Review progress by comparing planned (baseline) dates and actual start 

and finish dates, and by checking the progress of each task. 

Tables 

The Task Sheet view displays categories of information about the tasks, 

arranged in tables. The default table for the Task Sheet view is the Entry table, 

but you can select any of the task tables to display information about the 

project's tasks. 

Filters 

The Task Sheet view can use any of the task filters to display only the tasks you 

want to see. When you select a filter, the Task Sheet view displays the 

information as defined by that filter's criteria. The default filter is the All Tasks 

filter. 
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Resource Sheet 

Description 

The Resource Sheet view displays resource information in a sheet format, in 

which you can review information about each resource. Such information 

includes the payment rate, the number of work-hours assigned, and the 

planned (baseline) and actual cost. A resource can be an individual, a company 

or department, a piece of equipment, a room, or any other resource used for 

the project. 

Standard (default) views 

Seavus Project Viewer™ supports the standard Resource Sheet view, available in 

Microsoft® Project by default. 

Additional (custom) views 

If the project manager creates additional Resource Sheet views in Microsoft® 

Project, they can be viewed in Seavus Project Viewer™ as well. 

Best uses 

Use the Resource Sheet view to: 

 View the resource information. 

 Compare a resource's planned costs and work against actual costs and 

work. 

 Review the number of work-hours assigned to each resource. 

 Review resource costs. 

 Evaluate the effectiveness of a person on the project. 

Tables 

The Resource Sheet view displays categories of information about the resources, 

arranged in tables. The default table for the Resource Sheet view is the Entry 

table, but you can select any of the resource tables to display information about 

the project's resources. 
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Filters 

The Resource Sheet view can use any of the resource filters to display only the 

information you want to see. When you select a filter, the Resource Sheet view 

displays the information as defined by that filter's criteria. The default filter is 

the All Resources filter. 

Team Planner 

Description 

The Team Planner view belongs to the resource assignment category of views 

presenting the assigned tasks as well as the tasks that are not assigned to 

anyone (such as milestones or ordinary tasks). The Team Planner view is split in 

two frames arranged vertically in the view.  

In the upper frame of the view are presented all assigned tasks in the project 

plan while in the lower portion of the view are presented the tasks that missed 

resources. 

In each frame the project information is presented as a sheet on the left side of 

the view and as a chart on the right side of the view.  

The sheet portion presents resource information in a sheet format, in which you 

can review information about each resource.  

The chart portion displays each task graphically, most often as a task bar. The 

bar's length and position on the timescale indicate when that task begins and 

ends. In addition, if there is resource overallocation on particular tasks, the 

background on those tasks will be colored red. 

Standard (default) views 

Seavus Project Viewer™ supports the standard Team Planner view, available in 

Microsoft Project by default. 

Best Uses 

Use Team Planner view to: 
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 View tasks graphically while still having access to detailed information 

about the assigned resources; 

 View the tasks in the project plan that are unassigned; 

 View which resource is overallocated and on which tasks the 

overallocation occur; 

 View the unassigned areas and unscheduled areas in the project plan. 

Customization 

You are able to customize the Team Planner views in Seavus Project Viewer™, 

using one of the following opportunities: 

 Show or hide the unassigned tasks; 

 Show or hide the unscheduled tasks; 

 Expand or collapse the resource rows. 

Tables 

The Team Planner view does not make use of any table. 

Filters 

The Team Planner view can use any of the resource filters to display only the 

information you want to see. When you select a filter, the Team Planner view 

displays the information as defined by that filter's criteria. The default filter is 

the All Resources filter.  

Tables 

Overview 

In Seavus Project Viewer™, you can use the predefined Microsoft Project tables 

to show only the fields you want or create your own tables. There are two kinds 

of tables: task tables (which you can apply to task views) and resource tables 

(which you can apply to resource views). 

In Seavus Project Viewer™, you can change the table associated by the currently 

active view by using the Tables sub-menu of the View menu. 
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Besides using the Tables sub-menu of the View menu, you can also quickly 

change a table by right-clicking on the top-left cell on the sheet portion of the 

active view. 

Available Task Tables 

This is the list of standard task tables, available by default in Microsoft® Project, 

supported in Seavus Project Viewer™: 

 Cost – displays cost information about your project tasks (including cost, 

planned cost, variance, actual cost, and remaining cost). 

 Entry – displays basic information regarding tasks, including the task 

name, duration, start date, finish date, predecessors, and resource 

names. 

 Summary – provides an overview of basic project information, including 

task duration, scheduled start and finish dates, percent work complete, 

cost, and work. 

 Usage – displays project tasks and shows their work, duration, and start 

and finish dates. 

 Work – displays work information, including baseline work, work 

variance, actual work, overtime work, and remaining work. 

If the project manager created one or more custom task tables in Microsoft® 

Project and saved them in the project plan, Seavus Project Viewer™ will read 

them from the .mpp file and present them to you in the Tables menu, or the 

More Tables dialog. 

Available Resource Tables 

This is the list of standard resource tables, available by default in Microsoft® 

Project, supported in Seavus Project Viewer™: 

 Cost – displays cost information about your project resources (including 

cost, planned cost, variance, actual cost, and remaining cost). 

 Entry – displays basic information regarding resources, including the 

resource type, group, standard rate, overtime rate, cost per use, and 

accrual method. 



Chapter : User Reference 

Page | 23 

Seavus Project Viewer User Manual 

 Summary – provides an overview of the project resources, including the 

resource name, group, standard and overtime rates, maximum units, and 

peak units. 

 Usage – displays the project resources and shows how much work is 

assigned to each of them. 

 Work – displays work information, including baseline work, work variance, 

actual work, overtime work, and remaining work. 

If the project manager created one or more custom resource tables in Microsoft® 

Project and saved them in the project plan, Seavus Project Viewer™ will read 

them from the .mpp file and present them to you in the Tables menu, or the 

More Tables dialog. 

Filters 

Overview 

There are times when you want to view only a particular type of information in 

your project. For example, you may want to view only the milestones of your 

project or see tasks that have not started. If your project has many tasks and 

involves many resources, filters can be very useful for viewing a specific range 

of information. Filters allow you to display only the information you are 

interested in and hide the rest. Selecting a filter does not delete information 

from your project; it only filters it from your view. 

Seavus Project Viewer™ supports all standard task filters, available by default in 

Microsoft® Project, for viewing specific aspects of tasks and resource filters for 

viewing specific aspects of resources.  

In Seavus Project Viewer™, you can change the filter in the currently active view 

by using the Filters sub-menu of the View menu, or by using the Filters drop-

down box on the toolbar. 

Available Task Filters 

This is the list of standard task filters, available by default in Microsoft® Project, 

supported in Seavus Project Viewer™: 
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 All Tasks – shows all tasks regardless of their characteristics. 

 Completed Tasks – shows only those tasks that have been finished 

(marked as 100% complete) 

 Critical – shows all tasks that are on the critical path 

 In Progress Tasks – shows all tasks that have started but have not been 

completed 

 Incomplete Tasks – shows all tasks and assignments that have not 

finished, regardless of whether they have started 

 Milestones – shows only those tasks that are milestones 

 Summary Tasks – shows all tasks that are summary tasks 

 Unstarted Tasks – shows tasks that have not yet started 

Available Resource Filters 

This is the list of standard resource filters, available by default in Microsoft® 

Project, supported in Seavus Project Viewer™: 

 All Resources – shows all resources regardless of their characteristics 

 Resources – Material – shows material resources like wood, nails, or 

cement 

 Resources – Work – shows work resources like people and equipment 

 Work Complete – shows all completed assignments, and resources that 

have completed all their assigned tasks 

 Work Incomplete – shows all resources with an amount of scheduled work 

that is less than the amount of baseline work 

  



Chapter : Graphical Reports 

Page | 25 

Seavus Project Viewer User Manual 

Overview 

Seavus Project Viewer comes with brand new visual reports and dashboard, 

allowing team members, team leads and other project participant to view the 

health of the project plan. Using the visual reports team members can view the 

upcoming tasks, which tasks are behind the schedule or to get information 

regarding the critical tasks in the project plan while the team leads, project 

stakeholders can observe the tasks and resource costs and analyze whether they 

are aligned according the project budget or to be informed about the project 

status via the burndown reports.  

The following categories and reports are implemented in Seavus Project Viewer: 

 Dashboard category 

o Cost Overview 

o Work Overview 

o Project Overview 

o Upcoming Tasks 

 Resource category 

o R esource Overview 

 Cost category 

o Cost Overruns 

3.Chapter : Graphical 

Reports 
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o Resource Cost Overview 

o Task Cost Overview 

Important Note: Due to technical limitations, Graphical reports cannot be 

generated using: project plans from Microsoft Project Server, password 

protected files and project plans imported from Microsoft Excel, Microsoft 

Outlook, .xml file format. 

Report Types 

Project Overview Report 

Project Overview report informs the user about the % Complete of the project, 

upcoming milestones and the late tasks in the project plan.  

It consists of one Column chart - % Complete, showing the status of all project’s 

top level tasks. In addition to this chart, the Project Overview report contains 

two tables: 

 Milestone due table 

 Late tasks table presents the tasks in the project plan that are passed due 

compared with the current date 

Milestone due table presents the project’s milestone tasks that are coming 

compared with the current date. 

Late tasks table presents the tasks in the project plan that are passed due 

compared with the current date. 

Customize Project Overview report  

Project Overview report is customizable report. You can:  

 Change the position of the report’s label and the name of the report; 

 Customize the font, font size and the color of the report’s label 

 Format the line and the fill of the report’s label 
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 Change the position and the size of the graphic’s chart 

 Change the position and the size of the report’s table 

 Customize the font, font size, font color as well as the fill of the table’s 

cells  

The look of the Project Overview report is presented on the image below. 

 

Figure 1. Project Overview report 

Upcoming Tasks Report  

The Upcoming Tasks report shows the word done in the week, status of the 

remaining tasks and the tasks that starts soon, i.e. in the upcoming week. It 

consists of one Column chart – “Remaining Chart”, showing the status of the 

remaining tasks that are due in the reported week. 

In addition to the chart, the Upcoming reports contains one table, “Task Starting 

Soon”, containing information about project’s tasks that starts in the upcoming 

week, through several columns: Work, Start and Finish Date and Resource Name.  
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Customize Upcoming Tasks report 

Upcoming Tasks report is customizable report. You can: 

 Change the position of the report’s label and the name of the report 

 Customize the font, font size and the color of the report’s label 

 Format the line and the fill of the report’s label 

 Change the position and the size of the graphic’s chart 

 Change the position and the size of the report’s table 

 Customize the font, font size, font color as well as the fill of the table’s 

cells 

The look of the Upcoming Tasks report is presented on the image below.  

 

Figure 2. Upcoming Tasks report 
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Work Overview Report  

The Work Overview reports gives work statistic for all top level tasks in order 

user to know the percentage of completion and what’s left to be done. 

The Cost overview report consists of two charts: 

 Change the position of the report’s label and the name of the report; 

 Customize the font, font size and the color of the report’s label 

The work stats chart shows work stats for all top level tasks. 

The resource stats chart shows work stats for all work resources. 

Customize Work Overview report 

Work Overview report is customizable report. You can: 

 Change the position of the report’s label and the name of the report; 

 Customize the font, font size and the color of the report’s label 

 Format the line and the fill of the report’s label 

 Change the position and the size of the graphic’s chart 

 Change the position and the size of the report’s table 

 Customize the font, font size, font color as well as the fill of the table’s 

cells 

The look of the Resource Cost Overview report is presented on the image below.  
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Figure 3. Work Overview report 

Resource Overview Report  

Resource Overview report shows the working status of the project’s resource, 

the amount of work done and the remaining work.  

The Resource Overview reports consists of two Column charts: 

 Resource Stats 

 Work Status 

Resource Stats chart shows the Work status of all project’s resources presented 

through Actual Work, Remaining Work and Baseline Work. 

Work Status chart shows the % work done by all project’s resources. 

In addition to these charts, the Resource Overview report contains one table – 

“Resource Status” table, presenting the Remain Work for all resource in the 

project. 

Customize Resource Overview report 
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Resource Overview report is customizable report. You can: 

 Change the position of the report’s label and the name of the report; 

 Customize the font, font size and the color of the report’s label 

 Format the line and the fill of the report’s label 

 Change the position and the size of the graphic’s chart 

 Change the position and the size of the report’s table 

 Customize the font, font size, font color as well as the fill of the table’s 

cells 

The look of the Resource Overview report is presented on the image below. 

 

Figure 4. Resource Overview report 

Cost Overruns Report 

The Cost Overruns reports shows the cost variance for all top level tasks in the 

project plan and working resource in order to indicate whether the actual costs 

overruns the budget cost. 
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This report consists of two charts: Task Cost Variance chart, presented as Line 

chart, presenting the cost variance for the project’s top level tasks and Resource 

Cost Variance chart, covering the cost variance of the work resource. 

Customize Cost Overruns report 

Cost Overruns report is customizable report. You can: 

 Change the position of the report’s label 

 Change the name of the report 

 Customize the font, font size and the color of the report’s label 

The look of the Cost Overruns report is presented on the image below. 

 

Figure 5. Resource Cost Overview report 

Resource Cost Overview Report 

The Resource Cost Overview report presents the cost status for all working 

resources (human and material) in the project plan. It consists of Cost Status 

chart with information about the status of the work resource, Cost Distribution 
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pie chart showing how costs are spent among different resources and a Cost 

Details table for all resources. 

Customize Resource Cost Overview report 

Resource Cost report is customizable report. You can: 

 Change the position of the report’s label and the name of the report; 

 Customize the font, font size and the color of the report’s label 

 Format the line and the fill of the report’s label 

 Change the position and the size of the graphic’s chart 

 Change the position and the size of the report’s table 

 Customize the font, font size, font color as well as the fill of the table’s 

cells 

The look of the Resource Cost Overview report is presented on the image below. 

 

Figure 6. Resource Cost Overview report 
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Task Cost Overview 

The Task Cost Overview report presents the cost status for all top level tasks in 

the project plan. It consists of Cost Status chart with information about the 

status of the top-level tasks, Cost Distribution pie chart showing how costs are 

spent among tasks based on their status (complete, on schedule and future 

tasks) and a Cost Details table for all top-level tasks. 

Customize Task Cost Overview report 

Task Cost report is customizable report. You can: 

 Change the position of the report’s label and the name of the report; 

 Customize the font, font size and the color of the report’s label 

 Format the line and the fill of the report’s label 

 Change the position and the size of the graphic’s chart 

 Change the position and the size of the report’s table 

 Customize the font, font size, font color as well as the fill of the table’s 

cells 

The look of the Task Cost report is presented on the image below. 
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Figure 7. Task Cost Overview report 

Generate Graphic Report 

Creating graphic report in Seavus Project Viewer is very easy and can be done 

in several steps: 

1. Open project plan; 

2. From the View menu select the Report feature; 

 

3. New sub-toolbar will be displayed containing the main features for 

working with reports; 
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4. From Report drop-down list select the appropriate report; 

 

After selecting the report, Seavus Project Viewer will generate the selected 

report. Further user can customize the output of the report by changing the 

label’s, table’s or chart’s view or print the report. 

Edit Graphic Report 

Editing different elements from the Graphical reports, such as report’s label, 

table or table sheet, is performed using the features from the Task Panel. Task 

Panel is dynamically expanded working area that provides variety of features in 

correlation with selected element from the report. 

To modify some element from the report, perform the following steps (assumed 

that the graphical report is already created): 

1. Select report’s element; 

2. Click on the Format button on the far right corner of the Report sub-

menu and select the appropriate element for editing. 

All changes in the report are automatically saved. If user wants to clear 

customization and have the initial view of the report, he\she can reset the 

reports view by using the “Reset Report” feature located in the Reports sub-

menu. 

In the next chapters, user can read how to edit specific element from the report. 
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Edit Report Element – Label 

Labels are text fields in the reports. Their main role is to give description about 

report, charts and table. You can change the text format of the labels, their 

shape styles and their positions. 

To do customize report’s labels, perform the following steps: 

1. Select the label that will be customized; 

2. Click on the Format button; 

3. For editing the text select one from the available options: 

a. Shape Style for editing the color and of the label’s frame 

 

b. Text Format for editing the label’s text 

 

c. Arrange for editing label’s position 

 

Note: All changes in the report are automatically saved. If user wants to 

clear customization and have the initial view of the report, he\she can 
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reset the reports view by using the “Reset Report” feature located in the 

Report sub-menu. 

Edit Report Element – Table 

Report’s tables contain information for the selected items in tabular form. Like 

the labels, they can be visually customized in order to meet user’s expectation. 

To do customize report’s labels, perform the following steps : 

1. Select the table that will be customized; 

2. Click on the Format button; 

3. For editing the table select one from the available options: 

a. Shape Style for editing the color and of the table’s frame 

 

b. Text Format for editing the table’s text 

 

c. Arrange for editing table’s position 
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d. Table Data for editing table’s content 

 

Note: All changes in the report are automatically saved. If user wants to 

clear customization and have the initial view of the report, he\she can 

reset the reports view by using the “Reset Report” feature located in the 

Report sub-menu 

Change Report Chart 

Chart (or Data Chart) is type of diagram that organizes and represents a set of 

numerical data, derived from the project plan. Depend from the report’s type 

and the user’s needs, project data can be visualized on several ways. Seavus 

Project Viewer supports 22 chart types: 

 Feature Description 

 

Clustered Column Stacked line is used to show how parts of a 

whole change over time. Use it to show how 

segments of a whole change over time. 

 

Stacked Column Stacked column chart is used to compare 

parts of a whole. Use it to show how segments 

of a whole change over time. 
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100% Stacked Column 100% Stacked Column chart is used to 

compare the percentage that each value 

contributes to a total. Use it to show how the 

percentage each value contributes changes 

over time. 

 

Line Line chart is used to display trends over time 

(years, months, and days) or categories when 

the order is important. Use it when there are 

many data points and the order is important 

 

Stacked Line Stacked line is used to show how parts of a 

whole change over time. Use it to show how 

segments of a whole change over time 

 

100% Stacked Line 100% Stacked line is used to show the 

percentage contribution to a whole over time 

or categories. Use it to show the change to the 

percentage that each value contributes over 

time 

 

Line with Markers Line with Markers is used to show trends over 

time (years, months and days) or categories. 

Use it to show when there are few data points 

and the order of categories is important 

 

Stacked Line with Markers Staked Line with markers is used to show how 

parts of a whole changes over time. Use it to 

show how segments of a whole change over 

time 

 

100% Stacked Line with Markers 100% Staked Line with markers is used to 

show the percentage contribution to a whole 

over time or categories. Use it to show the 

change to the percentage that each value 

contributes over time 

 

Pie Pie chart is used to show proportions of a 

whole. Use it to show numbers that relate to a 

larger sum and always equal 100%. Do not use 

this chart if it contains many slices as angels 

are hard to estimate 

 
Pie of Pie Pie of pie is used to show the proportions of a 

whole. Use it to show values from the first pie 

and combine them in a second pie to make 

small percentage more readable or highlight 

the values in the second pie 

 
Bar of Pie Bar of pie is used to show proportions of a 

whole. Use it to show values from the first pie 

and combine them in a stacked bar to make 
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small percentage more readable or highlight 

the values in the stacked bar 

 

Doughnut Doughnut is used to show proportions of a 

whole. Use it instead of a pie chart when there 

are multiple series that relate to a larger sum 

 

Clustered Bar Clustered bar chart is used to compare values 

across a few categories. Use it when the chart 

shows duration or when the category text is 

long 

 

Stacked Bar Stacked bar chart is used to compare parts of 

a whole across categories. Use it to show how 

segments of a whole change over time 

  

100% Stacked Bar 100% Stacked bar chart is used to compare the 

percentage that each value contributes to a 

total. Use it to show how the percentage that 

each value contributes over time 

 

Area Area chart is used to show trends over time 

(years, months and days) or categories. Use it 

to highlight the magnitude of a change over 

time and the category order is important 

 

Stacked Area Stacked Area is used to show the relationship 

of parts to a whole over time or categories. 

Use it to draw attention to the total value 

across a trend and highlight the magnitude 

change over time 

 

100% Stacked Area 100% Stacked Area is used to show the 

percentage contribution to a whole over time 

or categories. Use it to highlight the 

magnitude of change to the percentage that 

each value contributes over time 

 

Radar Radar chart shows the values relative to a e 

center point. Use it when the categories are 

not directly comparable 

 

Radar with Markers Radar with Markers shows the values relative 

to a center point. Use it when the categories 

are not directly comparable 

 

Filled Radar Filled Radar shows relative to a center point. 

Use it when the categories are not directly 

comparable 

To change the chart type in the report, perform the following steps: 

1. Select the chart that will be changed; 
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2. Click on the Format button; 

3. From the Chart Type library select one report. 

Note: All changes in the report are automatically saved. If user wants to clear 

customization and have the initial view of the report, he\she can reset the 

reports view by using the “Reset Report” feature located in the Report sub-

menu. 

Add Chart Element 

After the report is generated, user can add different chart elements (in case the 

report contains chart). Depending from the chart’s type, user can customize the 

chart by adding the following elements: 

 

Changing chart elements in the report is very easy and it is performed in several 

steps: 

1. Select the chart in the report; 

2. From the Chart Layout section in the Format bar check the elements 

that will be visible in the chart. 
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Insert Filter 

Filtering the chart data will help you to get better, viewable report, from which 

you will see the important information in a second. Adding filter in the report 

doesn’t require much of your time and it can be done in just two steps: 

1. Select the chart in the report; 

2. In the Chart Data section, from the Filter drop-down list select the 

filtering criteria that matches your needs. 
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Note: Depending from the report’s type, the “Filter” drop-down menu will 

contain either task or resource filters. 

Add or Remove Fields 

Inserting field(s) in the report combined with the “Filter” option is very powerful 

feature combination. Comparing several fields from same category (for 

example: Cost, Actual Cost and Remaining Cost) will visualize the project’s 

information in more detailed way and help you to bring the make the right 

decision for your project. 

 

 Active Fields 

*Only for "Pie" chart category 

Except the “Pie” and “Radar” chart category, all other charts have the possibility 

to present several fields at time. In order to meet this requirement in the 

mentioned reports, we have implemented the “Active Field” feature that contains 

the fields that are added from the “Active Field” drop-down list. This feature is 

located in Chart Data section of the Format toolbar. 

How it Works? 

1. Select one field from the mentioned drop-down list (for example “Actual 

Work” and “remaining Work”); 
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2. Select some of the chart from the “Pie” category; 

3. The field that is presented in the Chart is marked with symbol in the 

“Active Field” drop-down list (For example: Actual Work field); 

 

4. Select another field from the “Active Field” (for example “Remaining 

Work”) 
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5. The “Pie” chart will be updated 
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Additional Features 

Timescale formatting 

Some views, such as the Gantt Chart, have a timescale at the top. By default, the 

timescale displays two tiers: a top tier and a bottom tier. You can adjust all 

timescale tiers independently to view your project at the level of detail you need.  

In addition, for some views you can also specify the options for presenting the 

non-working time, like the calendar which defines the working and non-

working days and time, the color and pattern that should be used when drawing 

the non-working time, and how to draw the non-working time in relation to the 

task bars. 

Date Format 

Specifies the format for displaying dates. The "Format Date" feature is located 

in the Format menu. Some information, such as time formats and the date 

separator are set through the Mac Control Panel. For more information, see your 

Mac OS X documentation. 

This is a global setting for the application. 

Printing 

To manage a project effectively, you may need to communicate project 

information to a variety of people. With Seavus Project Viewer™, you can print 

views that present the exact information you want. 

4.Chapter : Additional 

features 
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The process of printing the information you need can be as simple as clicking a 

button or as refined as customizing and previewing the existing views. No 

matter how simple or refined the process, printing a view or report consists of 

essentially the same steps: 

 Select the view that best presents the information you want – If a 

predefined view does not meet your exact needs, you can apply different 

tables or filters, or change the way tasks or resources. 

 Make display changes to the view – For example, you may want to scale 

information to fit on a single page. 

 Preview a view or report before it is printed – Previewing a view can help 

you verify content and display changes you made so you can adjust them 

again if necessary. 

 Print the view – To make printing as efficient as possible you can specify 

the options you want. For example, you can print a range of pages 

(defined by page numbers or dates), suppress blank pages, and print 

multiple copies. 

You can make changes to the way a printed view looks by specifying page setup 

options such as page orientation, scale, or paper size. The Print dialog for a 

view is directly accessible through the Print command on the File menu.  

Once you open the Print dialog, you can follow the steps below to specify the 

page and other printing options for a view. Some options may differ between 

different views as well: 

1. To define the number of the printout copies, insert value in the Copies 

field. 

2. To print all pages from the project plan, select the All radio button, in 

front of the Pages label. 

3. Select the From radio button in case you want to print specific pages of 

the project plan. Type the starting and finishing page in the appropriate 

fields. 

4. To change the paper size, click the paper size you want in the Paper Size 

drop – down box. 

5. To change page orientation, click Portrait (vertical) or Landscape 

(horizontal) icons. 
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6. To print specific time frame of the project plan, click on the Date Range 

radio button and select the starting and finishing point for the printout. 

7. To scale pages, type the percentage at which you want information to 

appear on your printed pages in the % Scale box. 

8. To adjust page fit (some views only), under Scaling, click Fit to, and then 

specify the number of pages you want in the pages wide by and tall boxes. 

9. To print the header and footer of the project plan, select the Print header 

and footer check-box. 

10. Select the Print ID column on all pages if you want the row’s ID to be 

visible on every page of the project printout. 

After performing this procedure you may print the document the way you want. 

Information dialogs 

Seavus Project Viewer™ provides the option to quickly review the scheduling 

option and other information about the project, tasks and resources through 

the various information dialogs available in the application. They match their 

counterparts in Microsoft® Project, thus anyone with some experience in 

Microsoft® Project will be able to easily follow the information presented there. 

This is the complete list of information dialogs in Seavus Project Viewer™: 

 Project Information – presents the basic scheduling information for the 

project, like start/finish date, if the project tasks are scheduled from the 

start or the end, and the base calendar used in the project. You can also 

access the Project Statistics dialog from this dialog as well. 

 Project Statistics – presents the overall project statistics for start and 

finish dates, duration, work, and costs 

 Task Information – presents detailed information about the selected task 

like name, duration, percent completed, priority, start and end dates, 

constraint information, deadline, task calendar, list of predecessors, 

assigned resources, task notes, etc. 

 Resource Information – presents detailed information about the selected 

resource like name, e-mail, type, booking type, availability, calendar, 

different cost rates, resource notes, etc. 
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In addition to these dialogs, Seavus Project Viewer™ has an interactive dialog 

that gives the user the opportunity to enter specific information and send this 

information to the project manager.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




